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Starting a New Project 

In this chapter you learn how to: 

• create and name a project, 

• set global options in the Summary Information dialog box, 

• understand Status Boxes, 

• use the Notes window, 

• select sections for a project, 

• open an existing project, 

• copy entire projects, 

• create folders, 

• create new sections, 

• copy sections within a project, and 

• import selected sections into an existing project. 
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Overview 
SpecLink comes with a template configuration. When you create a new project, SpecLink’s 
Master Template is the default foundation for the new project. You can subsequently use 
any project as the foundation for new projects by changing the Project Source as described 
in this chapter. 

In SpecLink, all information about a project, including all the sections in the project, is 
contained in a single project file. This file is an overlay over the SpecLink master database. 
When you make selections and edits, you are changing the overlay, but not the master in 
the background. When you open a project, imagine the project file as overlaying SpecLink’s 
master database of sections, modifying your view of the contents. 

Because everything about the project is contained in a single file, global decisions such as 
page format and choice of units of measure can be made in one place. Links between 
sections are also easy to implement, so this single file structure results in better project 
coordination. 

Creating and Naming a New Project 
To prepare a project specification, you first copy an existing project or start a new project. 
This section describes how to create and name a new project. 

1. From the File menu, choose New Project. The Save New Project As dialog box opens.  

NOTE: You can also choose the New Project icon from the Standard toolbar. 
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 This dialog box allows you to change the folder where your project will be saved.  If the 
default folder is where you want your project to be saved, simply type the new project 
name in and click on Save. To change the location where your project will be saved, 
click on the Save In drop down menu and navigate to the folder where you want the 
project saved, enter a file name, and then click on Save. 

NOTE: A file name can contain up to 255 characters, including spaces. But it cannot 
contain any of the following characters: \ / : * ? " < > |. Use a period only to 
separate the file name from the extension. SpecLink automatically attaches an 
.spp extension. 

NOTE:.To change the default projects directory, see the installation document located on 
the latest copy of the BSD SoftLink CD-ROM, or download it from our website: 
www.bsdsoftlink.com on the Support page. 

 
2. The Create New Project dialog box reopens, with the path for the New Project filled in. 

If both the Project Source and the New Project are correct, click OK.  
 
You can use any existing project or any sample or model project as the Project Source, 
i.e. the basis for your new project. The default project is a blank template (Master.spt) 
included as part of the master database. You can save editing time by changing the 
Project Source to an existing similar project. The Project Source will be copied and 
used as the starting point for the New Project. 

3. To change the Project Source click on the open folder icon to the right of the Project 
Source field to browse. When you click on the folder, the Open dialog box opens. 
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Open dialog box 

4. Navigate to and select the project file that you want to use as your project source. 

5. Click Open. The Create New Project dialog box reappears, with the new project 
source. 
 

 
6. Click OK  to create your new project. 

 The Project Window for the new project and the Summary Information dialog box 
appear. 

Once you complete the Summary Info dialog box and click OK, you have created a 
new project. "Setting Global Options," describes the Summary Info dialog box. 

Setting Global Options 
The Summary Info dialog box allows you to establish global settings for your project. Keep 
in mind that everything about the project is contained in a single file, allowing global settings 
to be made in one place. The dialog box will vary depending on whether you are in a 
SpecLink, PerSpective or Short Form tab in the Project Tree before you open it.  
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The SpecLink Summary Info Dialog Box – General Tab 
The SpecLink Summary Info dialog box contains the following global settings:  

 

SpecLink Summary Info dialog box 

File Name Displays the file name of the project. For reference only. 

File Path Displays where the project is saved. For reference only. 

Project 
Name 

Enter a meaningful name in the Project Name field. You can print the 
Project Name in the header or footer of your printed specification using 
a keyword. This is an optional field but is useful for managing your 
projects. This name also appears at the top of your tree panel.  

Project ID Enter an ID number in the Project ID field. You can print the Project ID in 
the header or footer of your printed specification. This is an optional field 
but is useful for managing your projects.  

Specific 
Terms 

You can overwrite the default terms to replace all occurrences of these 
words in the specifications text. You can customize terms for the 
following: Owner, Design-Builder, Design Professional, Contractor, and 
Project Location. The SpecLink master database does not use the term 
Design-Builder, but you may want to add this term for design-build 
projects. 
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 The Specific Terms appear in the Document panel in a green font, 
indicating a global choice. These terms can be replaced globally, in the 
Summary Info dialog box. You can also modify a single instance of a 
global term by blocking and deleting it, then entering a substitute term in 
your paragraph. 

 To overwrite a term, block the term and enter the new text. 

NOTE: It is best to use generic terms (like "Owner" or "Government") 
instead of filling in the actual owner's name. Where the terms appear 
in the sections the text may say "Use the Owner's choice." If you 
replaced the term Owner with the owner's name, it would then read 
"Use the Tom Smith's choice." Not only would you then have to fix 
the grammar in each place where it did not make sense, but the 
reader would also have to figure out who Tom Smith is. In the front 
end documents, you will have the opportunity to fill in the owner's 
actual name and that is followed by "hereinafter referred to as 
Owner." 

References SpecLink includes a single reference document—Section 01425—that 
includes a consolidated list of reference standards for the entire project. 
This list includes the acronym, the document number, the full title, and 
the current edition date (optional) of each standard. If you choose to 
include this section, links automatically include only the reference 
standards that are relevant to your project. There are two options that 
relate to reference standard citations; you can select either or both. 

Print Edition 
Dates 

When the section is printed, the edition dates are included with 
each citation. 

Consolidated 
List of Citations 

Check this option to produce a consolidated list of all the 
standards referenced in the project in Section 01425. 

NOTE: To produce this list, Section 01425 must be included in the project. 

Include 
Citations in 
Each Section 

Check this option for links to automatically select the 
References article heading under Part 1 General when any 
standards documents are cited in the section. 

Include Related 
Sections 

Check this option for links to automatically select the Related 
Sections article heading under Part 1 General when any other 
sections are referenced in the section. 
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MasterFormat 
Version 

Choose to display and print section numbers and titles in one of these 
four ways: MasterFormat 04, MasterFormat 95, MasterFormat 04 
(MasterFormat 95 in parentheses) or MasterFormat 95 (MasterFormat 
04 in parentheses). Click on the button for the option you want. If you 
choose to show a secondary hierarchy in parentheses, only the 
secondary section number will be displayed.  Only the section title for 
the primary hierarchy will display and print.  MasterFormat Version 
choices normally appear in the Document panel in a green font, 
indicating that the format is set globally in the Summary Info dialog 
box. However, where section titles are part of MasterFormat Version 
option, they appear in a blue font. The blue choice type allows you to 
use a fill-in the blank choice type when you want to input your own 
section title. 

MF-04 
Section ID 
Format 

Choose to display and print the MasterFormat 2004 section numbers 
in one of these three ways: 99 9999, 99 99 99, or 999999.  You can 
also select a separator to separate the digits if choosing 99 99 99 or 99 
9999. 

Unit of 
Measure 

Choose to display units of measure in one of these four ways: English 
(Metric), Metric (English), English, or Metric. Click on the option button 
for the option you want. Units of measure normally appear in the 
Document panel in a green font, indicating that the format is set 
globally in the Summary Info dialog box. However, where units of 
measure are part of multiple choice options, they appear in a blue font. 

NOTE: When a unit of measure value is entered in a fill-in choice, the software does 
NOT convert it to the other forms or units; you must enter the value. 

The Summary Info Dialog Box – Report Cover Sheet Tab 
The contents in the fields on this tab will print on a Cover Sheet when any of the 
Requirements Reports are printed. The cover sheet can be suppressed by un-checking the 
Reports Cover Sheet checkbox on the Reports Setup Dialog box. 

Allow BSD to Publish Project Data – This checkbox defaults to being checked when you 
create a new project or when you copy an existing project. When this field is checked, you 
are giving your permission for BSD to publish the information about your project, including 
your company name, in reports generated and distributed to a limited number of 
manufacturers who pay to receive this information for specific specification sections. 

The PerSpective and Short Form Summary Info Dialog Box 
The PerSpective and Short Form Summary Info dialog box contains the following global 
settings:  
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PerSpective and Short Form Summary Info dialog box 

Most of the fields on the Summary Info Dialog Box for PerSpective and Short Form 
are the same as the fields in the SpecLink Summary Info Dialog Box.  The following 
highlights only the differences. 

Document 
Function 

PerSpective includes a global switch that changes language 
throughout the database, depending on the intended use of the 
documents. Choose the appropriate function from the three that are 
offered, as follows: Building Design Criteria (an owner preparing an 
RFP), Proposed Performance Specifications (a design-builder 
responding with a proposal), or Construction Documentation 
(communications between members of the building team). 

References PerSpective includes a single reference document—Section 00840—
that includes a consolidated list of reference standards for the entire 
tab. This list includes the acronym, the document number, the full title, 
and the current edition date (optional) of each standard. If you choose 
to include this chapter, links automatically include all the reference 
standards that are relevant to your project. There are two options that 
relate to reference standard citations; you can select either or both. 

Print Edition 
Dates 

When the section is printed, the edition dates are included with 
each citation. 
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Consolidated 
List of Citations 

Check this option to produce a consolidated list of all the 
standards referenced in the project in Section 00840. 

NOTE: To produce this list, Section 00840 must be included in the project. 

Completing the Summary Info Dialog Box 
You can establish global settings in the Summary Info dialog box when you first start a new 
project, and change these settings at any time. To view or edit the Summary Info dialog box 
later, from the File menu choose Summary Info, or click the Open Database Summary Info 
dialog button on the toolbar. 

1. To add or edit the data in any field in the Summary Info dialog box, click on the field.  

NOTE: The File Name and File Path fields are for reference only. They cannot be edited. 

2. Enter your new text. Use the Tab key to navigate through the fields or click on each 
field to edit it. 

3. To change an option, click on the radio button or checkbox to select or deselect. 

4. When you have completed desired changes in the Summary Info dialog box, click OK. 

Notes about Specific Terms 
When you replace specific terms in the Summary Info dialog box, keep these hints in mind:  

• Any words can be used, but the sentence syntax and punctuation assume that nouns 
or proper nouns are used, and that possessives and other structures may be 
appropriate. 

• The duties of each entity, and what the specification says each is responsible for, are 
based on contractual relationships similar to those provided for in the standard 
American Institute of Architects (AIA), Associated General Contractors of America 
(AGC), and Engineers Joint Contract Documents Committee (EJCDC) contracts for 
design-build projects. 

• If the contractual relationships for the project are different from the standard AIA, AGC, 
and EJCDC relationships, substitution of a different set of names may not be sufficient 
to clarify modified responsibilities. In that case, it is advisable to examine each section 
for statements relating to the duties of the parties to the contract and to make 
modifications as necessary. If necessary, use the Find feature to search for specific 
terms. 
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Basic Concepts 
Unlike documents in a word-processing environment, where unwanted text is deleted to 
remove it, in SpecLink you select a section by clicking on its status box in the Tree panel to 
include it (or by clicking the status box of the title in the Document panel). Unselected 
sections are not included in your project and do not print. In addition, as you make text 
selections in the Document panel, software links automatically make other changes to the 
section and to other sections in the project. See the "Status Boxes" section in Chapter 3 for 
details about selected text. 

In the Tree panel, folders that contain active sections have a sheet icons ( ). When those 
folders are expanded, the sections that are included in the project are in a bold font. In 
addition, the status boxes of included sections are green, include a checkmark, or are 
green with a checkmark.  

NOTE: A selected section is always included in the project. If you wish to exclude a 
selected section, simply click again on the status box adjacent to the title. Click 
again to return section status to neutral. 

Status Boxes 
The status of each paragraph in a section is visually displayed in the box in the Status 
column to the left of the text in the Document panel, and the status of each section is 
visually displayed in the status box to the left of each document title in the Tree panel using 
symbols and colors. For complete descriptions of the symbols and colors, see Chapter 3.   

Using the Notes Panels 
To help you choose sections to include, the title of each section always has a note attached 
that includes a brief description of the section contents. To view the Notes, click on the 
name of the section you want to review and the note will appear in the master notes panel. 
(If the master notes panel is not visible, select it from the View menu.) 

To see the note on a different section, click on the name of the section you wish to view, 
and the Master Notes panel will display the notes for the section you select. You can 
therefore move quickly from section to section in the Tree Panel and see a quick overview 
of the section in the Master Notes panel.  

When a section is open, Notes attached to particular paragraphs appear in the Notes panel 
when the relevant paragraph has focus and the Notes panel is open. Paragraphs that have 
Notes are marked with an icon in the Notes (N) column to the left of the status box. The 
color of the icon indicates the type or types of notes available, as follows: 
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 Yellow notebook icon on left Master note is attached 

 Blue notebook icon on right Project note is attached 

 Both the yellow and blue 
notebook icons 

Both master and project notes are 
attached 

NOTE: For information on adding your own notes, see Chapter 5.  

Selecting Sections for a Project 
Once you have created a new project or opened an existing project, you can select 
sections to include and deselect sections that are not needed. You can also exclude 
sections, but it is not necessary to exclude them from your project to keep them from 
printing. Only selected sections, displayed with bold titles, are included in your project.  

1. To select or deselect a section, click once in its status box in the Tree panel, or click the 
status box of the section title in the Document panel. Remember that selected sections 
display the status box with a checkmark, a green background, or a combination of a 
checkmark and a green background. The title of the selected section is also displayed 
in a bold font. 

2. If you decide that you do not want a section that you selected, click the status box 
twice to return it to a neutral status. 

 See the "Status Boxes" section of Chapter 3 for a refresher about the status box color 
and symbol markings. 

3. Continue selecting the sections you want. 

 You can add or deselect sections at any time. 

NOTE: You can make section selections in the Tree Panel without actually loading the 
document into the Document Panel. This makes your selections faster. To load 
the section in the Document Panel, click on the section title in the Tree Panel. 

Which Sections are Included? 
Active sections, which are included in the project, have titles in a bold font, while inactive 
sections are shown in a normal font. Also, the status box of an active section is either green 
or includes a checkmark, as shown in the following illustration. 
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Selected sections in a project are indicated by titles in bold font 

Notice in this example that one section (14 2010 Passenger Elevators) has been selected 
automatically by a green link. Also notice that section 14 2705 Custom Elevator Cabs and 
Hoistway Doors was highlighted by the system (yellow triangles) and selected manually by 
the user (checkmarks). Other documents in this view have not been selected by either the 
user or the system (the Status box is a neutral gray square) and are not currently included 
(the section titles are in a normal font). 

The information in parentheses following each document title indicates the source of the 
document and the catalogs that have access to it. For example, 14 1100 Manual 
Dumbwaiters (VWC - ASCMELX) is a proprietary section authored by VWC (Vincent 
Whitney Company, Inc.) and is part of the Architectural, Structural, Civil, Mechanical & 
Electrical, Landscape, and Basics catalogs. The second set of parentheses indicates the 
last date and time the section was edited. 

Non-proprietary sections are authored by BSD and appear in the tree in blue font. 
Proprietary sections that are based on the products of a particular manufacturer appear in 
the tree in a black font. Sections that have been added by the user or master sections that 
have been copied appear in a green font. Sections that are not available for you to edit 
because they are being edited by other users appear in a gray font, and information in the 
parentheses is replaced with “in use by.” A gray font will also appear on sections that are 
not included in your subscription catalog.  
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NOTE: If the status box of a gray “in use” section is replaced by a red key, that section is 
currently checked-out by another user. See Chapter 9 for details. 

Opening an Existing Project 
1. From the File menu, choose Open Project.  

NOTE: You can also choose the Open Project icon from the Standard toolbar. 

 The Recently Used dialog box opens. Note that there are four different views of the 
recently used projects available. The view below shows Details of the files. 

 

Recently Used dialog box 

2. You can select a project from those presented in this window, or if the project you want 
to open is not listed, click the Browse button to open the Open Database dialog box. 

 If you click Browse, the Open Database dialog box opens to the default projects 
directory. 
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NOTE: As a shortcut, the last four projects used display at the bottom of the File menu. If 
you want to open one of those files, click on it. 

 

Open Database Dialog Box 

3. Go to the location of the project file you want to open, click on the file, and then click 
the Open button. 

 The project file opens. 

Reusing Existing Projects 
You can get a “jump start” on a new project by reusing previous work. Copy entire projects 
or individual sections from projects. With SpecLink, reusing the specifications from previous 
projects is actually the best way to improve your productivity. Here’s why:  

• No master text is ever deleted; it is always available for the next project. 

• New material added for a project is carried forward to the next project automatically 
and can be deselected if not relevant. 

• Notes are in a separate panel, not in the body of the document. (In a word processor, 
the notes would be in the body of the document and may be deleted from the original 
project. With SpecLink, the notes are stored separately from the text and would not be 
deleted.) 

There are three methods for copying projects: 
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• Changing the Project Source to an existing project (as described earlier in this chapter 
under creating new projects) 

• Copying an entire project (described next) 

• Importing sections from existing projects (described in the next section of this chapter) 

The first two result in the same file - an exact copy of the original project. The third method 
allows you to import only the specific sections that you need. 

NOTE: It may not be possible or desirable to reuse the last project specification, 
because more than one project may be in the works at the same time. In that 
case, a "master project file" offers the same benefits with only a slight increase in 
administration. By using Copy/Paste, and Import From Project, new material can 
be added quickly to the master project file from new projects. See Chapter 10 
"Creating a Master Project File" for details. 

Copying an Entire Project 
To copy an entire project including Summary Info settings, formats, and all selections and 
edits, use the following steps:  

1. From the File menu, choose Copy Project. 

 The Select Unopened File to be Copied dialog box opens. 

 

Select Unopened File to be Copied Dialog Box 
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2. Go to the location of the file you want to copy, click on the file, and then click Open. 

 The Enter Destination File Name dialog box opens. 

 

Enter Destination File Name Dialog Box 

3. Select a different folder in which to save the copy, if desired. Then enter a file name, 
and then click Save. 

 The copy will be made. 

4. To open the copy, from the File menu choose Open. The Recently Used dialog box 
opens. Since the copied project has never been open before, it will not be listed. Click 
the Browse button to locate and open the copy. 

5. Open the Summary Info dialog box (from the File menu, choose Summary Info) and 
edit the global settings to match the new project. 

NOTE: The Copy Project procedure does not change the Project Name of the copied 
project to match the file name. To change the name of the project, open 
Summary Info. 

Managing Sections In a Project 
SpecLink allows you to create new folders, copy existing sections, create new sections, 
and import selected sections from one or more projects into a new project. These features 
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allow you to take copy research performed for earlier projects into new projects, create new 
sections, and create new folders to better meet the scope of your new project. 

Adding Folders To the Tree 
The folders in the tree correspond to one of four possible hierarchies: MasterFormat 95 or 
MasterFormat 04 for SpecLink, UniFormat for PerSpective and MasterFormat 95 for Short 
Form Specifications.. These folders therefore are intended to cover all possible construction 
materials and systems. However, SpecLink allows you to add your own folders to the tree.  

A new folder will be inserted in the tree at the position determined by your cursor location 
and the command you use to add the folder. To add a child folder that should be listed last, 
click on the parent folder and select the command Insert Child Folder. To add a folder in the 
middle of a branch (instead of last), click on the existing folder that is below where you want 
the new folder, and select the command Insert Folder.  

Adding a New Folder to the Bottom of the Tree 
To add a Division 17 folder to the tree in MasterFormat 95, perform the following steps: 

1. In the Tree Panel, click on the Project title at the top of the Project Tree. 

2. From the Tree menu, choose Folders, and then Insert Child Folder… 

 The Add Child Folder dialog box appears. 

 

Add Child Folder dialog box 

3. Enter the title of your new folder (in this case, Division 17 – Technology 
Infrastructures), then click OK. 

 The new folder is added at the bottom of the tree, just above the Unassigned Sections 
folder. 

Renaming and Deleting Folders 

You can rename any folder or delete a folder you have added at any time. To rename any 
folder or to delete a user-added folder, first click on the folder, then from the Tree Menu, 
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choose Folder, and then choose Rename Folder or Delete Folder. The folder must be 
empty in order for you to delete it. 

Adding New Sections 
No matter how many sections are in the master database, there may be a need for 
additional sections. SpecLink includes four ways to add new sections.   

• The Add New Section function allows you to create new sections built on a 
template with all major article headings and standard "boilerplate" text. Use 
this method if you are going to type in the text or copy in small parts of the text 
from another document.  

• Add New Section From RTF File allows you to use the complete section 
from another document, such as Word or WordPerfect.  

• Copy Section copies existing sections from within the same project. 

• Importing sections from another project is the fourth way to get a new 
section into your project. 

Add New Section 
To create new sections, you follow a procedure similar to adding new folders:  

1. Position your cursor in the Tree Panel on the folder that will contain your new section. 

2. Using your right mouse button menu click on Add New Section or from the Document 
menu, select Sections, then Add New Section… 

 The Add Section dialog box opens. 

 

Add Section dialog box 

3. Enter a section ID and section name, then click OK. You may also change the 
acronym, but we recommend leaving it as USER for easy identification. 
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NOTE: The software will not allow you to add a section number/acronym combination 
already in use in the master database or in your project. If you add a section in 
the wrong place, use Cut Section and Paste Section to move it (see details later 
in this chapter). 

The new section is added to the Tree Panel in the appropriate location, based on the 
number and acronym assigned. 

4. Click the status box adjacent to the title to include the new section in the project, and 
edit the content just as you would a master section. 

NOTE: Sections in SpecLink are numbered and titled in accordance with the 1995 or 
2004 edition of CSI's MasterFormat™ -- Master List of Numbers and Titles for 
the Construction Industry. To be consistent with this numbering scheme, we 
strongly suggest you acquire a copy of the appropriate document from CSI. 

The SpecLink Section Template 
The template copied by the Add New Section command (while in the SpecLink tab) is the 
CSI Three-Part Section Format, including PART and Article headings down to level 2, plus 
standard language for many PART 1 and PART 3 topics. 

Listed below are the Article titles provided in the SpecLink template, which should be used 
to the degree possible. The 3 PARTs are always used. Articles marked with an asterisk are 
almost always used. 

PART 1 GENERAL 
SECTION INCLUDES* 
RELATED SECTIONS* 
ALLOWANCES 
UNIT PRICES 
ALTERNATES/ALTERNATIVES 
REFERENCES* 
DEFINITIONS 
SYSTEM DESCRIPTION 
DESIGN REQUIREMENTS 
PERFORMANCE REQUIREMENTS 
SUBMITTALS* 
QUALITY ASSURANCE* 
MOCK-UP 
PRE-INSTALLATION MEETING 
DELIVERY, STORAGE, AND PROTECTION 
PROJECT CONDITIONS 
ENVIRONMENTAL REQUIREMENTS 
WARRANTY 
EXTRA MATERIALS 
MAINTENANCE SERVICE 

PART 2 PRODUCTS 
MANUFACTURERS* 
[BASE BID] MANUFACTURER 
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MATERIALS* 
[PRODUCT] 
[COMPONENTS] 
ACCESSORIES* 
MIXES 
FABRICATION 
SHOP FINISHING 
SOURCE QUALITY CONTROL [AND TESTS] 

PART 3 EXECUTION 
EXAMINATION* 
PREPARATION* 
INSTALLATION*/APPLICATION/ERECTION 
INTERFACE WITH OTHER WORK 
ERECTION TOLERANCES 
FIELD QUALITY CONTROL 
STARTING EQUIPMENT [AND SYSTEMS] 
ADJUSTING 
CLEANING AND PROTECTION 
SCHEDULES 
END OF SECTION 

Since the new section does not exist in SpecLink's master database, all of the paragraphs 
will be user-added paragraphs, and therefore completely editable. Notes are included in the 
Section Template to explain how to use each article so that new sections you create can be 
consistent with the existing sections. 

Copying the Section Template 
When you add a new section in the SpecLink tab, SpecLink copies the SpecLink Section 
Template, Section 99999 (9 99999 in MF04). If there are edits you would have to make for 
every new section you create, customize Section 99999 or 9 99999 just as you would edit 
any other section. You can copy text from the Section Template to other sections.  When 
you add a new section while in a PerSpective or Short Form tab, the PerSpective Section 
Template will be copied.  See below for the PerSpective/Short Form Section Template. 
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Section 99999 – SpecLink Section Template 
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The PerSpective and Short Form Section Template 

Add New Section from RTF File 
If you already have the section you want to add in a word processing or RTF (rich text 
format) file, it is faster to create a new section using Add New Section from RTF file. 

There are two settings on the Tools menu that need to be set correctly before you use Add 
New Section from RTF.  If you have Auto-Select New Paragraphs turned on, then all 
paragraphs imported during the Add New Section from RTF will be selected with a 
checkmark.  There is a menu selection called Look for Choice Fields in Import.  If this is 
turned on (reflected by a checkmark in the menu choice) then the import will create choices 
within the section, based on the formatting outlined below.  If the Look for Choice Fields in 
Import is not turned on, then the software will not create choices in your section and 
brackets will import as brackets, for example. Unless you have specifically edited your file 
to import choices, it is better to leave this selection off.  See below for more information on 
importing choices. 

Your RTF file must be formatted correctly for the new section to be added correctly.  The 
following guidelines should be followed: 

• The file must be a true RTF file.  To save a word processing document as an RTF file, 
open it in your word processing software and choose Save As, selecting Rich Text 
Format (RTF) as the file type. 

• The word “Section” must be in the first non-blank line in the document. 

• This word must be followed by one or more spaces followed by the Section ID number. 
Up to 15 characters are allowed. MasterFormat 95 Section IDs may only be 5 
characters in length. 

• The number may be followed without space by an acronym (If no acronym is 
discovered the acronym will default to “USER”). 

• The Section Title is expected to be the second non-blank line in the document.  A 
properly delimited note (see below) may precede the Section ID or the Section Title 
and will be assigned to the Section Title. 

Any or all of the above information can be edited in the dialog box following file selection. 
 
Example of first two lines of an RTF file: 
 
Section 07550 
MODIFIED BITUMEN ROOFING 
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• Paragraphs beginning with the word “Part” and one of the words “General”, “Products” 
or “Execution” will import at Level 1.  The test is not case-sensitive. 

• Other levels (hierarchy) are determined basically by the amount of space between the 
left margin and the first printable character on the line, regardless of how the space 
was created. 

• Since SpecLink has its own auto-numbering system, the import from RTF attempts to 
remove numbers and letters from the beginning of a line. From the beginning of a line 
up to five characters followed by a tab will be recognized as an auto-number to be 
removed. 

• When a paragraph is indented 2 or more levels below its parent it will be promoted until 
it is only one level below its parent. 

• Lines beginning with 10 or more asterisks will be recognized as the boundary 
beginning or ending text that should be treated as a Note to the following paragraph.  
To import a note on a paragraph, it should be formatted like this: 
 
**********  

This is the project note for Paragraph One 
**********  
Paragraph One 

• Blank paragraphs in specification text are discarded; blank lines within notes are 
maintained. 

• The phrase “End of Section” is assigned to Level 1.  If there is no End of Section at the 
end, it will be added by SpecLink.  
 
Note: If the phrase Endo of Section is anywhere within the RTF file, SpecLink will 
consider that to be the end of the section and will not import the remainder of the 
document. 

Additional notes about import: 
• Documents with paragraph marks at the end of every line, instead of only at the end of 

paragraphs, should be cleaned up before importing, since each line will import as a 
new paragraph. 

• Hard line breaks are treated as new paragraphs.  If you don’t want a paragraph 
numbered in SpecLink, drag across the paragraphs once they are in SpecLink and 
from the Document menu choose No Auto Number. 

• SpecLink does not import tables from Word directly.  You need to convert tables to 
tabbed text before importing. 
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To create a new section using Add New Section from RTF File, use the following 
steps:  

1. Position your cursor in the Tree Panel on the folder that will contain your new section. 

2. Using your right mouse button menu, select Add New Section from RTF File… or from 
the Document menu, select Sections, then Add New Section from RTF File… 

 The Import from Rich Text Format Documents window opens 

 
3. Navigate to the folder where the RTF file is, click on it and then click on Open. 

The Add Section dialog box opens. 

 

Add Section dialog box 

4. Enter a section ID and section name, then click OK. You may also change the 
acronym, but we recommend leaving it as USER for easy identification. 
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NOTE: The software will not allow you to add a section number/acronym combination 
already in use in the master database or in your project. If you add a section in 
the wrong place, use Cut Section and Paste Section to move it (see details later 
in this chapter). 

The new section is added to the Tree Panel in the appropriate location, based on the 
number and acronym assigned. 

 

The Rules for importing Choices  
In the table below are the proper formats for choices you wish to import into SpecLink.  
Note that these conventions will be honored only if you have the Tools menu choice of Look 
for Choice Fields in Import turned on.  Also note that if this choice is active, choices will be 
imported when you use Add New Section from RTF, as well as when you use Import from 
Clipboard (Control-V). 

 
Description Marker Note 
Exclusive 
Choice List 

[[apple] [orange] [banana]] 
or [[apple] [orange] [[______]]] 

Used as selection for no 
optional text 

Optional Text <<apple>> User can select text or 
None – N/A 

Optional, One 
required, AND 

~~and<<apple>><<orange>> 
<<banana>>~~ 

Must pick at least one, can 
pick more, AND connector 

Optional, One 
required, OR 

~~or<<apple>><<orange>> 
<<banana>>~~ 

Must pick at least one, can 
pick more, OR connector 

User Defined 
Fill-in 

[_____________] User fills in 

Reference 
Date 

|<date>|  

Owner #O# Globally defined term for 
Owner 

Design Builder #D# Globally defined term for 
Design Builder 

Design Prof #A# Globally defined term for 
Design Professional 

Contractor #C# Globally defined term for 
Contractor 

Project 
Location 

#S# Globally defined Project 
Location 

Unit of 
Measure 

{{cubic feet (cubic meters)}} 
or {{[[inch][foot][yard]]([[cm][meter] 
[meter]])}} 

Globally defined unit of 
measure 
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Description Marker Note 
MasterFormat 
Version 
Choice (MFV) 

Section {+{MF04 (MF95)}} 
Section {+{[[MF04] [____]] ([[MF95] 
[____]])}} 

Format the MF04 number 
as 00 0000 -- the space is 
required. The first 
character in 
the import must be 
something other than the 
initial brace. 

PerSpective 
Document 
Function 

[+[Text for Building Design Criteria] 
[Text for Proposed Performance 
Specifications] 
[Text for Construction 
Documentation]] 

The three options 
correspond to the 
Document Function setting 
on the PERSPECTIVE 
Summary Info dialog -- 
may be used in 
PerSpective and Short 
Form only. (In SpecLink 
it imports but does not 
switch -- the first option 
shows.) 

 

NOTE: See “User-Added Choices” in chapter 5 for how to edit, delete, and add choices 
within SpecLink. 

 

Copying Sections Within a Single Project 
Copy an entire section within a single project when you need to make two variations of the 
same section in the same project, or if you want to copy a proprietary section and edit it to 
make it generic. Copy the section to a new acronym, and then edit the new section. 

NOTE: To copy sections from one project to another, see Importing Sections Into a 
Project later in this chapter. 

To copy an entire section within a single project: 

1. In the Tree panel, click on the title of the section to be copied. 

2. Using your right mouse button menu, click on Copy Section or from the Document 
menu, point to Sections, and then click Copy Section. 

 The Copy Section for Pasting dialog box opens. The current Section ID, Acronym, and 
Section Name are displayed. 
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Copy Section for Pasting dialog box 

3. Verify that this is the section you want to copy, then click OK to proceed. 

4. In the Tree panel click on the folder that will contain the pasted copy. 

5. Using your right mouse button menu click on Paste Section Into… or from the 
Document menu, point to Sections, and then click Paste Section Into…. 

 The Paste Section Into… dialog box opens. 

 

Paste Section Into… dialog box 

6. The Copy Section To portion of the dialog box defaults to the current section ID and 
Name. The Acronym is changed to USER to indicate that it is a user added section. If 
desired, change the Section ID, Acronym, and/or Section Title. Then click OK. 

 The copied section appears in the Tree panel with its new section number and/or title. 

NOTE: If you mistyped the name, in the Document panel, drag the pointer across the 
current name to highlight it and then type the correct name. Click on a different 
paragraph to save your edit and the name will update in the Tree panel. If the 
Section ID or Acronym is wrong, use the Moving a Section steps below to Cut 
and Paste the section. 
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Moving a Section 
If a user-added or copied section is in the wrong folder, has a wrong Section ID, or has a 
wrong Acronym, fix this by cutting and pasting the section. 

You cannot cut a section from the master database. 

To move and/or renumber a user-added or copied section:  

1. In the Tree panel, click on the title of the section you want to move and/or renumber. 

2. Using your right mouse button menu click on Cut Section… or from the Document 
menu, point to Sections, and then click Cut Section… 

 The Cut Section for Pasting dialog box opens. 

 

Cut Section for Pasting dialog box 

3. Verify that this is the section you want to move and/or renumber, and then click OK 
(Otherwise, click Cancel). 

4. In the Tree Panel, click on the folder that will contain the moved and/or renumbered 
section. 

5. Using your right mouse button menu click on Paste Section Into… or from the 
Document menu, point to Sections, and then click Paste Section into… 

 The Paste Section Into… dialog box opens. 
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Paste Section Into… dialog box 

6. Change the Section ID and/or the Acronym, if desired. You can also change the 
Section Name; however, it is not necessary to cut and paste a section in order to 
change the section name. When all desired changes have been made, click OK. 

 The section is moved to its new location in the Tree panel, and/or the ID is changed. 

NOTE: It is not necessary to Cut and Paste a section in order to change the section 
name. To change any section name, view the section in the Document Panel, 
drag across the text of the current title to highlight it, and then type the new 
name. Click on a different paragraph to save your edit and the section name will 
update in the tree. If in the SpecLink tab, the name change will be effective for 
the current hierarchy only. If you need to change the section name for both 
MasterFormat 95 and MasterFormat 04, the change needs to be done in each 
hierarchy. 

Deleting a Section 
If you added or copied a section in error, or if the added or copied section will never be 
needed again, delete it. You can delete user-added or copied sections. You cannot delete a 
section from the master database. 

It is not necessary to delete a section in order to omit it from your project specification. 
Rather than deleting, deselect the section by clicking in the status box to return it to a 
neutral state. For more information, see the section on Status Boxes in Chapter 3. 

To delete a user-added or copied section: 

1. In the Tree panel, click on the section you want to delete. 
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2. Using your right mouse button menu click on Delete Selected Section or from the 
Document menu, point to Sections, and then click Delete Selected Section. 

3. You will be asked to verify the deletion. When you click OK, the selected section is 
deleted. Note that if you are in the SpecLink tab, deleting the section in one MF 
hierarchy deletes the section in both hierarchies. 

NOTE: Be certain you want to delete the section before clicking OK, because it is not 
possible to UNDO this process. 

Importing Sections Into a Project 
If you copy an entire project, as described in the previous section of this chapter, it may be 
necessary to deselect certain sections or edit them heavily. Import from Project allows you 
to select for copying the specific sections you need. You can import sections from multiple 
projects, combining them as appropriate for your new project. 

Importing sections gives you a "jump start" on a new project because you can reuse your 
previous work. Keep in mind that you did not modify the Master, so don’t worry about losing 
any of that information.  

Importing BSD master sections causes the same selections and edits to be made to those 
sections in the new project as in the old project. Importing user-added sections creates the 
section and the text in the new project. 

NOTE: User-added sections will not automatically import to the correct folder. If you will 
be importing sections that you created, click on the folder you would like those 
sections to import to prior to starting the import process. 

To copy sections from one project to another using Import From Project: 

1. Open the project that you are going to import from to make sure that it has been 
opened in the current version of the software. Once the project that you are going to 
import from has been opened in the current version, you can close it.  

2. Open the project to receive the imported sections. 

3. In the Tree panel click on any folder. Or, if you will be importing any user-added 
sections, click on the folder that should contain the user-added sections. 

NOTE: If you will be importing multiple user-added sections that belong in different 
folders, you can create a temporary folder using the directions for adding folders 
earlier in this chapter, and then import the user added sections to that folder. 
Once they have imported, use Cut Section and Paste Section to move the 
sections to the folders where they belong. 
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4. From the Tools menu, choose Import from Project. Or click the Import Sections from 

External Project button on the toolbar . 

 The Import from Project dialog box opens.  

 

Import From Project dialog box 

5. Click on the folder icon at the end of the Project to Import From field. 

 The Open dialog box opens. 

 

Open dialog box 
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6. Move to the location of the project file you want to import sections from, click on it, and 
then click Open. 

 The selected project appears in the Import from Project dialog box, with all sections in 
the project listed in the lower window. 

 

Import from Project dialog box with project selected 

7. Active sections are listed in bold type. To see active sections only, select the checkbox 
Active Sections Only. 

NOTE: You may also want to deselect Verify Before Overwriting Existing Sections since 
this will ask you to confirm importing each master section. 

8. Click on the section you want to import, or hold the Ctrl button down to click on 
multiple sections. Alternatively, you can click on the Select All button. 

9. When you have finished with your selections, click the Import button. The selected 
sections are copied into the project you have open. 

 


